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1. Cree un Proyecto 

 
Creando un proyecto, usted puede hojear a través de archivos. 

1.  Cree un proyecto Haga clic en Archivo → Nuevo Proyecto 

Posición: la carpeta donde usted desea crear el archivo de proyecto 

Nombre del proyecto: Nombre del archivo de proyecto usted desea crear. El archivo de 

proyecto tendrá la extensión.sur o.pur  

2.  Si los archivos de la fuente o los archivos de jefe tienen 
extensiones además de *.c, *.cpp, *.h 

 

3.  Añada archivos de la fuente y archivos de jefe al proyecto Haga clic < Añaden los Archivos> en el Menú de Dirección de Proyecto. 

Seleccione el "All Source Files" de botón de radio y Chasquido  

O Seleccione archivos de la lista mostrada y chasquido  

4.  Póngase el "incluyen secuencia de camino" Haga clic < Incluyen el Camino> en el Menú de Dirección de Proyecto. 

No es bastante añadir simplemente los archivos de jefe al proyecto … 

− Seleccione el "Incluyen subcarpetas” caja si los archivos de jefe son #included de 

las subcarpetas también. 

5.  Analice Todos los Archivos Haga clic < Analizan Todos> en el Menú de Dirección de Proyecto. 

6.  Después del análisis sintáctico, compruebe archivos de jefe 
Ausentes. 

Haga clic < Ausencia Incluye> en el Menú de Dirección de Proyecto 

Si los archivos de jefe fallan, algunos nombres de tipo pueden permanecer indeterminados y 

causar errores de sintaxis. 

Los errores de sintaxis son mostrados en el color rosado. 

Si un error de sintaxis implica un jefe de la función (el principio de una función), entonces la 

función no es reconocida y de ahí su organigrama no está disponible. 

7.  Si algún archivo de jefe falla: Añada que las carpetas necesarias al "incluyen la secuencia de camino" de modo que el Flujo de 

Cristal pueda encontrar los archivos de jefe 
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8.  Después de añadir carpetas al "incluyen la secuencia de 
camino": 

Analice de nuevo Todos los Archivos haciendo clic < Nuevo análisis Todos> en el Menú de 

Dirección de Proyecto. 
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2. Archivo de jefe falso & Extensiones de Lengua 

1.  Si su código contiene non-ANSI C 
palabras clave: 

Use el archivo del jefe falso o las extensiones de Lengua para manejar non-ANSI C palabras clave:  

 
Las extensiones de lengua pueden ser apoyadas por medio del archivo de jefe falso o por medio de la tarjeta de 

extensiones de lengua del menú Options:  

Déjenos comenzar con un ejemplo:  

__ usert TBool find_ele (int *arr_p, int amax) 

{ 

... 

}  

a) Desde ANSI el C no reconoce __ usert y TBool, usted puede añadir una declaración o #de fino para __ 

usert y TBool en el archivo de Jefe Falso de Proyecto. REVS de cristal automáticamente #includes el 

archivo de Jefe Falso de Proyecto a principios de cada archivo en el proyecto.  

Usted puede abrir el archivo de Jefe Falso de Proyecto del menú desplegable "de Proyecto" "o el cristal" de 

Archivos de Prj de la Ventana Hojear.  

El archivo de Jefe Falso de Proyecto parece a cualquier otro archivo de jefe, usted puede corregirlo y 

salvarlo. Usted puede #include otros archivos en ello.  

#i fndef dummy_header_is_included_once 

#de dummy_header_is_included_once fino 1  

# defina __ usert  

typedef int TBool;  

#endi f  

Después de que usted modifica el archivo de jefe falso, lo salva y Nuevo análisis Todos los archivos. 

b) O usted puede usar la tarjeta de Extensiones de Lengua del Menú de Opciones. Usted puede añadir un 

nuevo esquema. Entre en TBool en "los Tipos" y chasquido . De manera similar añada __ 

usert a la columna "de Otros".  

(La adición a la columna "de Otros" tiene el mismo efecto que #de __ fino usert como mostrado encima.)  

Ambo archivo de Jefe Falso de Proyecto y ajustes de Opciones son salvados en un "por base de proyecto".  
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3. Organigrama 

1.  Cree un Organigrama Coloque el cursor en todas partes en una función. Haga clic <Crean el Organigrama> e n la barra de 

herramientas o prensa   

2.  Organigrama de Vista y Código al lado Haga clic en el botó n debajo de la ventana para mostrar el código y organigrama lado al lado. 

 Código de toque de luz en ventana File Haga clic en la mitad correcta de un símbolo de organigrama para destacar el código correspondiente en la 
ventana File. 

 La voluta destacó el código en la 
ventana File 

Mientras el código correspondiente es destacado, haga clic en los iconos de voluta o e n la barra de 
herramientas de organigrama 

3.  Información de Tipo de Vista a. Haga clic en la mitad izquierda de un símbolo de organigrama. 

b. El planeo el puntero del ratón sobre un objeto llama en el símbolo de organigrama. 

4.  Vea las condiciones que tienen que ser 
verdad  

Ver las condiciones que tienen que ser verdad a fin de alcanzar el símbolo de organigrama corriente: 

- Seleccione <Se muestran/Esconden la Ventana Externa> e n la barra de herramientas en lo alto del 
condensar-organigrama. 

En la secuencia de condiciones que son mostradas debajo del organigrama condensado  

- Haga clic en cualquier condición en la secuencia para ir al símbolo correspondiente. 

5.  Barra de herramientas de Organigrama Haga rodar el puntero del ratón sobre botones de barra de herramientas para ganar la familiaridad 

6.  Símbolos de Alto nivel Un símbolo de alto nivel es indicado por una frontera morada gruesa. 

 Cobertura de Código de Vista Haga clic en la parte izquierda de un símbolo de nivel alto para ver el código cubierto por ello.  

 Amplíe un símbolo de alto nivel Doble click en un símbolo de alto nivel para ampliarlo. 

 Símbolos de colapso al nivel corriente Presione dos veces el ratón en la mitad correcta de un símbolo bajo para caer todos los símbolos a aquel nivel 

7.  Level-n-flowcharts Haga clic, o de modo que la vista condensada muestre la cantidad "correcta" del 
detalle; ni simplificado demasiado ni demasiado atestado. 

Haga clic el <Crean un Organigrama óptimo> para ver el nivel de falta. 
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8.  Divídase y Triunfe Para funciones largas, consiga la vista entera de la función viendo que es el organigrama de nivel superior. 

Entonces vea los organigramas de son partes principales, como declaraciones del interruptor grandes, lazos, 
etc. 

9.  Cree un suborganigrama Haga clic,  el 2do icono de la cumbre en la barra de herramientas de ventana Flowchart  

- cuando un símbolo "de interruptor" en el organigrama es seleccionado, el icono es llamado "Crean el 

Organigrama de Interruptor Corriente" … del mismo modo, para "un mientras" símbolo, "un para" el símbolo 
etc. 

 Cree un organigrama del interruptor 

(De manera similar cree el flowcahrt de 
un mientras-lazo, si más, para el lazo 
etc.) 

a. Coloque el cursor en una declaración de interruptor en la ventana File;   

haga clic Organigrama → Crean Organigrama de Código de interruptor de � 

b. Haga clic en un símbolo de interruptor en el organigrama;  

haga clic <Crean el Organigrama de Interruptor Corriente> es decir el 2do icono en la barra de 
herramientas 

 Cree un suborganigrama más profundo 
En el suborganigrama corriente, seleccione el nivel "correcto" del detalle con, luego cree un 

suborganigrama como necesario 

 Vuelva al organigrama paternal Haga clic e n la barra de herramientas de la ventana Flowchart 

 Vuelva al suborganigrama Haga clic e n la barra de herramientas de la ventana Flowchart 

10.  Vaya al organigrama de una función 
Llamada 

El chasquido correcto en un símbolo que contiene una llamada de la función.  

Haga clic <Crean el Organigrama para la llamada de función> entonces hacen clic en ‘el nombre de función’.  

Use <el modo de Cambio> cerca del fondo de la barra de herramientas para ir de acá para allá 

entre el organigrama del visitante y llamar-organigrama 

11.  Amplíe llamadas de la función en un 
organigrama 

En primer lugar, usted tiene que crear un organigrama extensible como descrito abajo. 

 Cree un Organigrama extensible Coloque el cursor en todas partes en la función. 

Haga clic en el menú CallFlow�Expand desplegable Llamadas en un Organigrama de Función Lleno 

 Amplíe una llamada de la función La presencia de una llamada de la función es indicada por el encima del símbolo. 

- Presione dos veces el ratón en un símbolo que contiene una llamada de función.  

La extensión es insertada justo antes de la llamada de función. 
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 Colapso una extensión Presione dos veces el ratón en el símbolo de principio de una extensión 

12.  Ventana de Organigrama Transparente Cuando la ventana de organigrama traslapa la ventana File, usted puede ver las líneas de la 
fuente cubiertas por el organigrama: 

- Haga clic e n la barra de herramientas de ventana de organigrama para hacer la 
ventana de organigrama transparente. 

13.  Navegación en Organigrama  

 Teclas de dirección y la llave de Casa - Presione las teclas de dirección para andar por el organigrama. Presione la llave de Casa para ir al 
principio de organigrama 

 Icono de mano para arrastrar y moverse - Haga clic para seleccionarlo. Ahora usted puede el chasquido-y-rastra para moverse al organigrama. 

14.  Destaque una o varias conexiones  

 Destaque una conexión de 
Organigrama 

Haga clic en una conexión para destacarlo. 

 Todas las conexiones que llegan a una 
declaración 

Haga clic en la entrada de un símbolo de organigrama. Todos los caminos que entran en la entrada son 
destacados. 

 Todos los caminos que dejan un 
símbolo de alto nivel 

Haga clic en la salida de un símbolo. Todos los caminos que salen de aquella salida son destacados. 

 Destaque otra conexión Para destacar otra conexión reteniendo destacar corriente, apriete y luego haga clic en una conexión 
para destacarlo. 

15.  Distinción visual en un organigrama 
monótono 

Por favor vea los contenido de Ayuda. (Organigramas-> Operaciones Básicas-> Como añadir …) 

16.  Búsqueda de texto en un organigrama - Cuando en un organigrama, haga clic e n la barra de herramientas principal. 

- Entre en "el texto" para ser buscado. 

- Haga clic <en la Señal Todos> - los símbolos con el texto que hace juego son highlighter. 

- Use y ver los símbolos que contienen las cuerdas que hace juego 

17.  Personalizar 
 

 Etiquetaje de ramas Verdaderas y 
Falsas 

Usted puede personalizar el texto mostrado en SÍ Y NINGUNOS caminos de un "si declaración.”. 

- Haga clic en el Organigrama �Customize para ver el menú de opciones 
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 Ajustes de Organigrama El organigrama es controlado y personalizado por varios ajustes del organigrama.  

- Haga clic <en Ajustes de Organigrama> e n la barra de herramientas de organigrama para modificar 
ajustes. 

 Aspecto de Organigrama Haga clic en el Organigrama �Appearance para personalizar la mirada y el aspecto del organigrama 

 Personalice ventana Flowchart Personalizar las fuentes, tamaño de la fuente, posición de barra de herramientas, conexión y grosor de línea 
de símbolo, etc.: 

- Haga clic en el Organigrama �Customize para ver el menú de opciones 

 Personalice formas para llamadas del 
sistema 

Las formas de símbolo para llamadas de función pueden ser personalizadas. Personalizar formas: 

- Haga clic en el Organigrama �Customize Formas para ver los Nombres de Función Asociados con el 
diálogo de Formas.  

18.  Tipos de organigramas 
 

 Organigrama de Código - Haga clic <en el modo de Cambio> en la barra de herramientas de organigrama y luego seleccione 
<el Interruptor para Cifrar el Organigrama>  

 Organigrama de Comentario Coloque el cursor dentro de la función 

- Haga clic el menú Flowchart desplegable → Crean el Organigrama de Comentario de la función corriente 
→ 

 Código + Organigrama de Comentario - Haga clic <en el modo de Cambio> y luego seleccione <el Interruptor para Cifrar + Organigrama de 
Comentario> 

19.  Comentarios Especiales En un organigrama de comentario, usted puede sustituir un lazo, un interruptor o unas declaraciones con un 
comentario total. 

Por favor vea los contenido de Ayuda. (Organigramas-> Comentarios Especiales …) 

20.  Imprima un organigrama 
 

 Presentación preliminar El chasquido correcto en la ventana de organigrama; Haga clic <Presentación preliminar> en el menú 
instantáneo. 

En la ventana Print preview, haga clic en el botón de "Tile Pages" para ver páginas múltiples o una página 
sola. 



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

11 

 Apresto para letra a. El chasquido "Acerca" "o Aleja" en la barra de herramientas de organigrama entonces ven la Presentación 
preliminar. 

b. Usted puede imprimir el organigrama entero en una página sola: 

- El chasquido correcto en la ventana de organigrama; Haga clic en la Letra; Seleccione "el 
Organigrama en la Página Sola" 

- Use el menú File desplegable-> Sistema de Página-> Organigrama 

21.  Organigrama de Exportación 
 

 Organigrama de exportación-
.jpg.bmp.html 

Con la ventana de organigrama activa, use la Imagen de Organigrama de menú Flowchart�Export 
desplegable 

Del mismo modo, usted puede el chasquido-y-rastra para seleccionar una parte del organigrama y exportarlo 
como un mapa de bit. 

 Organigrama de exportación a Visio El chasquido correcto en la ventana de organigrama; entonces haga clic "en la Exportación de Visio" 

Con la ventana de organigrama activa, use el menú Flowchart desplegable → Visio Exportación 
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4. Árboles – Llamada, Visitante, Archivo, Base, Sacada, Proyecto, Relación 

1. Llame Árbol Coloque el cursor dentro de una función. Haga clic e n la barra de herramientas 

2. Árbol de Visitante Coloque el cursor en un nombre de función. Haga clic e n la barra de herramientas 

3. Árbol de Llamada de Archivo El árbol de Llamada de Archivo muestra la relación entre todas las funciones en el archivo corriente.  

Esto le ayuda a empezar con entendimiento y repaso del archivo. 

− Haga clic en Árbol de Llamada de Archivo Tree→Create 

4. Árbol de Archivo El árbol del archivo muestra archivos que son #included en el archivo corriente.  

− Haga clic e n la barra de herramientas principal 

5. Árbol de Dependencia de Datos Coloque el cursor en cualquier objeto de los datos.  

− Haga clic <Crean el Árbol de Dependencia de Datos> i cono en la barra de herramientas. 

6. Árbol de Clase Bajo Un árbol de clase bajo es un árbol de la clase corriente y son clases bajas.  

− Coloque el cursor en un nombre de clase.     

− Chasquido correcto, luego haga clic en Clases Bajas. 

7. Árbol de Clase Sacado Un árbol de clase sacado es un árbol de la clase corriente y esto ha sacado clases. 

− Coloque el cursor en un nombre de clase.     

− Chasquido correcto, entonces, chasquido Clases Sacadas 

8. Incluya Por Árbol Incluir por el Árbol muestra archivos que incluyen el archivo corriente.  

− Coloque el cursor en todas partes en el archivo corriente.    

− Haga clic los Tree→Create Incluyen Por Árbol 

9. Árbol de Llamada de Proyecto Un Árbol de Llamada de Proyecto es el Árbol de Llamada de todas las funciones de raíz de un proyecto. 

− Asegúrese que todos los archivos en el Proyecto han sido analizados (en el menú Project Management). 

− Haga clic en Árbol de Llamada de Tree Project 



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

13 

10. Árbol de Archivo de Proyecto Un Árbol de Archivo de Proyecto es un árbol de archivo de todos los archivos de proyecto. Los archivos no 
incluidos por cualquier archivo son al primer nivel.  

− Asegúrese que todos los archivos en el Proyecto han sido analizados (en el menú Project Management). 

− Haga clic en Árbol de Archivo de Proyecto de Tree→Create  

11. Árbol de Clase de Proyecto Asegúrese que todos los archivos en el Proyecto han sido analizados (en el menú Project Management). 

− Haga clic en Clases de Proyecto de Tree→Create o prensa +   

12. Árbol de Relación de Archivo del archivo 
corriente 

Un Árbol de Relación de Archivo muestra los archivos de los cuales el archivo corriente usa Globals o 
Funciones. 

− Coloque el cursor en todas partes en el archivo corriente. 

− Haga clic en el Árbol de Relación de Archivo Tree→Create 

13. Árbol de Relación de Clase de la clase 
corriente 

Un Árbol de Relación de Clase muestra las clases que usan a los Miembros de Datos o miembros de Función 
de la clase corriente. Tales clases no deberían estar en la jerarquía de la clase corriente. 

− Coloque el cursor en un nombre de clase. 

− Haga clic en Árbol de Relación Tree→Class 
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5. Operaciones de árbol 

1. Nodos del árbol de orden de nombre Haga clic <en Ajustes de Árbol> e n la barra de herramientas de árbol. En el popup, haga clic en nodos de 
Árbol de Llamada sorting�By Nombre 

O bien, usted puede usar el menú TreeSettings desplegable � 

2. Nodos de árbol de orden por acontecimiento 
de la llamada 

Haga clic e n la barra de herramientas de árbol. En el popup, haga clic en nodos de Árbol de Llamada 
sorting�By Occurrence�Show Todos los Acontecimientos 

Para pedir por la primera llamada de una función y esconder sus otras llamadas, haga clic <en el 
Espectáculo Primer Acontecimiento> en el susodicho. 

3. Funciones de biblioteca de espectáculo,  

funciones indeterminadas etc. 
Hacer clic . En el popup, encienda el artículo deseado o Lejos. 

4. Amplíe el árbol entero Ampliar totalmente el subárbol bajo el nodo corriente,  

Chasquido correcto en todas partes en la ventana Tree; Haga clic <Se amplían Lleno> 

 Amplíese una vez Para guardar el árbol compacto, los nodos de árbol que han sido ampliados una vez no son ampliados otra 
vez. 

- Haga clic e n la barra de herramientas de árbol. La vuelta <Se amplía Una vez> EN. 

5. Prefijos de Nodo - P - indica que el nodo es una aguja de una función.  

- L - indica que es un archivo de función/biblioteca de biblioteca.  

- A - indica que esta función fue adjudicada a la aguja a la función o usada para inicializar una aguja 
para funcionar en una declaración  

- * -  indica que la función es recurrente  
- X - indica que la función es declarada, pero no definida.  

- ? - indica que la función es ni declarada, ni definida 

6. Vaya a la llamada de la función Un chasquido solo en un nodo en el árbol de la Llamada: 

− mueve el cursor a la primera llamada de la función después de la posición de cursor corriente.  

− Los chasquidos subsecuentes moverán el cursor a la siguiente llamada de la función en la función 
corriente 
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7. Vaya a la definición de la función En un Árbol de Visitante o árbol de la Llamada, dóblese tecleo en un nodo para ir a la definición de aquella 
función. 

8. Escriba a máquina la información del nodo 
corriente 

Ver el prototipo (o la declaración llena) de la función en el nodo corriente,  

Chasquido correcto en todas partes en la ventana de árbol.; Haga clic <en la Información de Tipo> en el menú 
popup. 

9. Busque en el árbol  

 La utilización de la Búsqueda embala la 
barra de herramientas de búsqueda 

Con la ventana Tree activa, use la lista desplegable en el Panel de Búsqueda en la barra de instrumento 
principal. 

Esto mostrará todos los nombres de funciones en el árbol.  

− Entre en pocos primeros caracteres de la función deseada.  

− Cuando la función deseada es visible en la lista, doble click y entrar en ello en el panel de búsqueda.  

− Presione la llave entrar. 

 La utilización de los iconos de 
Búsqueda en la barra de herramientas 
principal 

Haga clic para ir al siguiente acontecimiento del nodo corriente en el árbol.  

Haga clic para ir al acontecimiento anterior del nodo corriente en el árbol. 

10. Secuencia de la llamada de vista a) Camino de la llamada de la raíz al nodo corriente.    

b) Caminos de la llamada de raíz a todos los acontecimientos del nodo corriente. 

 Secuencia de la llamada a nodo 
corriente 

El chasquido correcto, luego haga clic <en el Camino de Espectáculo>. 

 Vea todas las secuencias de la llamada  El chasquido correcto, luego haga clic <en el Espectáculo Todos los Caminos>. 

 Muestre el árbol entero  

(los nodos de secuencia de la llamada 
son destacados) 

Después de ver una secuencia de la llamada,  

− Para ver el árbol entero otra vez, el chasquido correcto, luego hacen clic <en el Espectáculo Árbol 
Entero>  

− Para apagar destacar de los nodos de la secuencia, el chasquido correcto, luego hacen clic <en el 
Camino de No señal> 

11. La navegación en el árbol  



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

16 

 Use la llave de Casa, Teclas de 
dirección 

Presione de ver la raíz de un árbol bastante largo 

Presione de movers e hacia abajo al mismo nivel o al nodo del niño 

Presione de movers e hacia arriba al mismo nivel o al nodo paternal 

Presione de ampliar el subárbol del nodo corriente y moverse a es el primer niño. 

Presione de sufrir un colapso el subárbol corriente e ir al padre del nodo corriente. 

También intente el +,  + y el + combinaciones claves . 

 Vaya al nodo paternal Haga clic e n la barra de herramientas o apriete el + combinación clave . 

 Vuelva a anterior / Van a después - Haga clic e n el árbol. Alternativamente, usted puede apretar + combinaciones claves . 
Cuando usted hace clic en este icono repetidamente, usted alcanzará el primer nodo que fue visitado. 

- Haga clic en el árbol. Alternativamente, usted puede apretar + combinaciones 

claves . Cuando usted hace clic en este icono repetidamente, usted alcanzará el último nodo 
visitado. 

12. Señal / se esconde  

 La marca y la no marca de nodos Marcar un nodo: Seleccione el nodo haciendo clic en ello; Haga clic en la barra de herramientas 

No marcar un nodo: Seleccione el nodo haciendo clic en ello; chasquido correcto, luego haga clic <No señal> 

 Vaya a un nodo marcado/abajo Haga clic o ir hacia arriba o hacia abajo a un nodo marcado. 

 El ocultamiento y el no ocultamiento de 
nodos 

Esconder un nodo insignificante,  

− Seleccione el nodo que usted desea esconder. Haga clic en e n la barra de herramientas 

No esconder un nodo escondido, 

− Haga clic e n la barra de herramientas y seleccione el nodo en el cual usted desea no esconder el 

Chasquido e n la barra de herramientas 

13. Ajustes de Árbol Haga clic en e n la barra de herramientas para cambiar los ajustes. Para detalles, refiérase para Ayudar. 
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14. Aspecto de Árbol Haga clic en Tree→Appearance para personalizar la mirada y el aspecto del organigrama 

15. Personalice la Ventana de Árbol Personalizar las fuentes, tamaño de la fuente, posición de barra de herramientas, etc., Chasquido 
Tree→Customize. 

16. Árbol de Exportación  

 Exportación como.jpg.bmp o.html Exportar una parte del árbol como un Mapa de bit: 

- Seleccione la parte del organigrama para ser exportado por la rastra y escogido. 

- En la ventana de organigrama, haga clic en Imagen de Árbol de Exportación de Tree→ �Selected 

Exportar un árbol como un Mapa de bit: 

- En la ventana de organigrama, haga clic en el Árbol Tree→Export Image→Whole. 

 Exportación como un archivo.txt Exportar un árbol como un archivo de texto: 

- En la ventana de árbol, haga clic en el Árbol Tree→Export Image→Whole. 

- Después de especificar el nombre del archivo, en la Imagen de Exportación Como el diálogo, 
seleccionan los Archivos de tipo – a archivos TXT, y, luego hacen clic <Exportación> 

17. Cree el organigrama del nodo corriente - Haga clic e n la barra de herramientas de Árbol  

18. Cree CallFlow del nodo corriente - Haga clic e n la barra de herramientas de Árbol  



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

18 

 

6. Hojee Ventana 

1. Hojee Ventana Varios naipes en la Ventana Hojear le ayudarán a hojear en el: 

- nivel de proyecto 

- nivel de archivo 

- nivel de función 

Usted puede imprimir los contenido de la Ventana Hojear o exportación como-text-file. 

2. Archivos de Proyecto <Archivos de Prj> 
tarjeta 

En la tarjeta de Archivos Prj, 

- El intento presiona dos veces el ratón y el chasquido correcto en un nombre de fichero 

- Chasquido correcto en el nodo de raíz para añadir archivos al proyecto, corrija la secuencia de camino 
incluir 

3. Proyecto Hojea <Prj Hojean> tarjeta En Prj Hojean, usted puede ver la lista de todos: 

- funciones, funciones de raíz, funciones recurrentes, funciones condicionadas, globals, structs y uniones, 
etc. 

El intento presiona dos veces el ratón y el chasquido correcto en cualquier nodo. 

 Vaya a la definición de una Función - Presione dos veces el ratón en un nombre de función 

 Vea funciones Recurrentes - Haga clic en "+" para ampliar "las Funciones Recurrentes" nodo. 

 Imprima el Árbol o Exportación como un 
archivo de texto 

- El chasquido correcto en el nodo de raíz; Haga clic en "Letra" o Chasquido en "la Exportación al Archivo de 
Texto"  

4. Informe de Proyecto <Informe de Prj> tarjeta En el Informe de Prj, usted puede ver la lista de archivo por archivo de: 

- funciones, funciones de raíz, funciones no usadas, globals, structs y uniones, enums 

- #de multas, typenames, Archivos #included, globals no usado, vecinos no usados 

 Vista / Esconde artículos Específicos Como un ejemplo, sólo para ver el Globals en cada archivo: 

- El chasquido correcto en el nodo de raíz; Haga clic en Se amplían / Colapso Group�Globals 

Esconder todos otros grupos: 

− El chasquido correcto en el nodo de raíz; Haga clic en Se amplían / Colapso Group�Globals 

 Imprima el Árbol o Exportación como un 
archivo de texto 

- El chasquido correcto en el nodo de raíz; Haga clic en "Letra" o Chasquido en "la Exportación al Archivo de 
Texto"  
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5. Interruptor A  − Presione dos veces el ratón en un nombre de Función Recientemente Visitado 

− Presione dos veces el ratón en un nombre de fichero Abierto – para ir a aquella ventana 

6. Contorno Vea el contorno del archivo corriente. 

Vaya a cualquier función, comentario, #include, #i fdef etc.in el archivo haciendo clic en la ventana Outline. 

 Lista de funciones en el archivo corriente − Haga clic en el icono para ver la lista de funciones en el archivo. Presione dos veces el ratón en una 
función para ir a su definición 

− Haga clic en otros iconos para seleccionar/no reelegirlos. 

 Use el Contorno para andar por el 
archivo 

En ��la Ventana Options�Environment�Browse, seleccione "Van al Acontecimiento en el Chasquido Solo 
en el Contorno" 

− Haga clic y seleccione cualquier artículo en la tarjeta de Contorno de la Ventana Hojear. 

− Simplemente presione la llave en el teclado para ir al siguiente artículo y así andar por el fie. 

 Vea el #i f, #i fdef, etc. afecte Cuando usted selecciona un #i fdef, etc. en la lista en la tarjeta de Contorno: 

− el panel inferior muestra el alcance del #i fdef y los artículos que son afectados por ello. 

7. Informe de Archivo Vea una función y el resumen de datos del archivo corriente. Presione dos veces el ratón para ir a la línea 
correspondiente en el archivo. 

8. Organigrama La tarjeta de organigrama muestra una vista condensada del Organigrama. 

 Vea las condiciones que deben ser 
verdad 

Seleccione <Se muestran/Esconden la Ventana Externa> e n la barra de herramientas para mostrar la lista 
de condiciones que encierran el símbolo de organigrama corriente. 

9. El contorno de la función El Contorno de Función / la demostración de Contorno de Área un contorno esquelético de la función corriente 
o Class/Namespace. Es útil para navegar en áreas largas. 

Usted también puede ver la secuencia de todo el #i f, #i fdef, #else etc. en el archivo. 

 Vea las condiciones que deben ser 
verdad 

En la parte inferior usted puede ver la secuencia de condiciones - si, más, ya que mientras etc. que debe ser 
verdad a fin de alcanzar la línea corriente en la ventana File 

10. Propiedades de Propiedades/Área de 
Función 

Vea y vaya a: 

- Los visitantes de la función corriente, las Funciones llamaron por la función corriente 

- Estructuras, #de multas, globals etc. usado por la función corriente 

Intente el chasquido solo y presione dos veces el ratón en los nodos. 



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

20 

 Visitantes de funciton corriente Amplíese el "Llamado Por" nodo 

- Presionar dos veces el ratón en un nombre de función le tomará a la definición de aquella función. 
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7. Navegación 

1. Muestre Botones Rápidos Haga clic <Hacen la Ventana de Archivo más Alta> icono en el fondo de la Ventana de Cristal. 

O haga clic en menú ViewTall desplegable � 

2. Pedido externo Haga clic para mover el cursor al nivel de pedido externo.  

3. Salte Pedidos más Profundos Haga clic en alguno- .     

Por ejemplo: 

- para ir de una función al anterior / después funcionan 

- salte el cuerpo de un lazo 

- ir de un caso al anterior / siguiente caso 

4. Condene la navegación sabia Chasquido o botone s para ir a la oración siguiente o anterior. 

Usted puede saltar una declaración con initializer muy largo – con sólo un chasquido solo. 

5. Función navegación sabia Haga clic o ir a la función siguiente o anterior 

6. Vuelva y Vaya adelante Para volver a la posición sólo anterior - usted corregía en – chasquido   

Para volver al punto donde usted hizo clic en el anterior Van atrás, hacen clic  

7. Contexto de Música pop Chasquido para volver al archivo-y-posición que precede al más reciente hojea la operación. 

8. Vaya a líneas Modificadas Visite las líneas de código que fueron modificadas por usted haciendo clic y .  

REVS de cristal para C y C ++ recuerda líneas modificadas hasta a través de sesiones. 

9. Vaya a líneas Marcadas Visitar las líneas marcadas: haga clic y . 

10. Voluta media página - Haga clic para traer la línea corriente a la cumbre de la pantalla. 

- Haga clic para traer la línea corriente al medio de la pantalla. 

- Haga clic para traer la línea corriente al fondo de la pantalla. 
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11. Palabra siguiente o Anterior Buscar una palabra entera: 

- Coloque el cursor en un nombre de función o identificador 

- Haga clic el o  

Objeto 
siguien
te o 
Anterio
r 

Buscar un objeto según el C/C ++ 
reglas de alcance: 

- Coloque el cursor en el objeto  

- Haga clic o   

-  

13. Encuentre y Sustituya  

 Búsqueda de Texto sin formato / 
Búsqueda de Objeto 

Usted puede usar el panel de búsqueda en la barra de herramientas de búsqueda o el diálogo Encontrar. 

 Búsqueda Léxica Buscar una secuencia de señales según C/C ++ reglas léxicas  

(no haga caso de diferencias en la cantidad de espacio en blanco, partido a través de límites de línea) 

- Haga clic el e n la barra de herramientas de búsqueda o prensa + para traer el diálogo 
Encontrar. 

- Ponga el modo a Búsqueda Léxica 

- Entre en la cuerda de búsqueda en "la Búsqueda" del panel. 

- Póngase el Alcance – Archivan/Funcionan/Seleccionan el texto. 

- El chasquido <Encuentra> 

 Búsqueda de Expresión Regular Buscar una expresión regular  

- Haga clic e n la barra de herramientas de búsqueda o prensa + para traer el diálogo 
Encontrar. 

- Ponga el modo a Búsqueda de Expresión Regular 

- Entre en la expresión regular en "la Búsqueda" del panel. 

- Póngase el Alcance – Archivan/Funcionan/Seleccionan el texto. 

- El chasquido <Encuentra>  
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 Líneas de Señal Marcar todas las líneas que contienen una cuerda que hace juego 

- Haga clic e n la barra de herramientas de búsqueda o prensa + para traer el diálogo 
Encontrar. 

- Ponga el modo de búsqueda 

- Entre en la cuerda de búsqueda 

- Póngase el Alcance – Archivan/Funcionan/Seleccionan el texto. 

- Haga clic <Marcan Todos>. 

14. Encuentre en Archivos (GREP) Apriete + o haga clic en el en la barra de herramientas de búsqueda para mostrar Encontrar 
en el diálogo de Archivos. 

- Ponga el Modo de Búsqueda: Texto, Expresión Léxica, Regular, Objeto, Objeto Modificado. 

- Especifique la cuerda de búsqueda en “la Búsqueda” del panel. 

- Especifique las carpetas objetivo: Usted puede seleccionar uno de ARCHIVO CORRIENTE, ARCHIVOS 
DE ESCRITORIO, O PROYECTAR ARCHIVOS, o, usar el botón Browse y seleccionar la carpeta. 

- Haga clic en el botón <Perform>. 

Los resultados de búsqueda son mostrados en la ventana de salida bajo la tarjeta GREP. 

Usted puede ver los resultados como una lista o como un árbol con  

 Donde acontecimientos modificados Los acontecimientos modificados de un objeto son aquellos acontecimientos donde el objeto está siendo usado 

a la izquierda el lado de una asignación, o, los contenido del objeto están siendo modificados pasando el objeto 

como una referencia a una función, o, el objeto está siendo sujetado a incremento pre o postal o decrementos. 

Encontrar todos tales acontecimientos de un objeto en el proyecto 

- Coloque el cursor en el identificador deseado.  

- El chasquido correcto, luego haga clic “Donde Acontecimientos Modificados”. 

 GREP y Sustituyen En la ventana de salida, en la tarjeta GREP 

- Haga clic para traer el diálogo Sustituir. 

- Especifique Sustituir Por el texto. 

- Compruebe/No compruebe los artículos de Modificación de Archivo deseados. 

- Especifique una de la opción de Acontecimientos Sustituir – Corriente,"" Todos en el archivo corriente "y" 
En todos los archivos”. 

- El chasquido <Sustituye>. 
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15. Vaya a Definición, Declaración y Prototipo - Chasquido correcto en la VENTANA de Archivo, luego haga clic <ShowDefinition> para ir a la definición de 
cualquier objeto. 

- Chasquido correcto en la Ventana de Archivo, luego haga clic <ShowDeclaration> para ir a la declaración 
más cercana de cualquier objeto. 

- Coloque el cursor en un nombre de función y haga clic en Goto→Prototypes para ver el prototipo de una 
función 

16. Partido de par perfecto 
Cuando el cursor está en uno de: ([, {/* y usted hace clic,  el cursor se mueve a la 
correspondencia),],}, */y viceversa. 

Emparejando tirantes, es decir {y}, no es necesario colocar el cursor exactamente en la abrazadera.  

Usted puede colocar el cursor en todas partes en la línea  

17. DE UN #i f, #i fdef a correspondencia #else, 
#endi f, y viceversa 

Cuando el cursor está en un #i f, #i fdef, #i fndef, haga clic para ir a la correspondencia #else, #eli f o 
#endi f. 

18. Inspección de objeto no declarado Haga clic en bajar el cursor a un acontecimiento de un objeto que es no declarado y no #de multado 
tampoco.  

19. Inspección de objeto no usado El chasquido de movimiento s el cursor a la declaración de un objeto local que no ha estado usado 
en el programa. 

20. Inspección de tirantes incomparables Haga clic en Goto Find Errors Unmatched más, (/* etc. para bajar el cursor  

- a una abrazadera incomparable es decir {o},  

- un comentario incomparable delimiter es decir “/ *” “o * /”, o, 

- un incomparable "más" es decir "más" para que no hay "si". 

21. Inspección de errores de sintaxis El chasquido en Goto Find Errors Next Error de Sintaxis baja el cursor a C/C siguiente Sintácticamente 
incorrecto ++ oración (si uno está presente).  

Con esta operación usted puede encontrar errores de sintaxis en un programa (hasta sin necesidad tener de 
compilarlo) 
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22. Margen de Contorno 
Haga clic en Instrumentos → Margen de Nivel de Pliegue de Espectáculo para ver el Margen de Contorno para 
cada función dentro del archivo. 

- Haga clic en ‘-‘para caer el nivel corriente en la función. 

- Haga clic en ‘+’ para ampliar un nivel en la función. 

- Chasquido correcto en ‘+’ para ampliar todos los niveles bajo el nivel corriente. 
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8. Árboles ricos                                                              

Los Árboles Ricos son árboles de la llamada o árboles del visitante donde cada nodo de la función contiene la información adicional para ojeada fácil y entendimiento del 
código de proyecto. 

1.  Cree un Árbol Rico 1. Cree el árbol de la Llamada deseado o árbol del Visitante 

2. Haga clic <en la Búsqueda en el Árbol> e n la barra de herramientas de ventana Tree para abrir la 
Búsqueda en el diálogo de Árbol. 

3. En la tarjeta de Demostración Permitir, seleccione la información adicional que debería ser mostrada con 
cada nodo de función. 

4. El chasquido <Se aplica> 

5. También use "la tarjeta" de Búsqueda de Objeto para buscar objetos de datos específicos y mostrarlos en 
los nodos de árbol relevantes 

2.  “La Búsqueda en Árbol” diálogo 
Haga clic el <Búsqueda en el Árbol> e n la barra de herramientas de Ventana de Árbol para ver “la Búsqueda en el 
diálogo de Árbol”.  

 

 La tarjeta de Demostración Permitir Use esta tarjeta para: 

− Permita/incapacite la información que es mostrada junto a cada nodo 

 La tarjeta de Acontecimientos de Toque 
de luz 

Use esta tarjeta para: 

− Seleccione el criterio por el cual otros acontecimientos de un nodo son destacados  

 La tarjeta de Búsqueda de Objeto En esta tarjeta,  

1. Especifique el objeto de datos o nombre de struct, etc. 

2. Encuentre en que funciones el objeto de datos está usado - haciendo clic <en la Búsqueda> o <Búsqueda 
Todos> 

 La tarjeta de Búsqueda Avanzada Usando esta tarjeta, usted puede: 

− encuentre el siguiente acontecimiento de una función en el árbol.  

− encuentre la siguiente función usada de un archivo específico. 

− use "la lista de historia" para buscar un objeto particular, struct, clase, escribir a máquina o #de fino  

− busque una cuerda en todo el texto que está siendo mostrado en los nodos del árbol..  

3.  Ate la información a nodos de árbol Use el "Permiten la Demostración” tarjeta en “la Búsqueda en el Árbol” diálogo 
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 Parámetros de vista de funciones Seleccione “la Lista de Parámetro de Función”; el chasquido <Se aplica>. 

 Profundidad de pila de vista en cada nodo Seleccione “el Tamaño de Pila”; el chasquido <Se aplica>. 

 Nombres de fichero donde Funciones son 
definidas 

Seleccione "Nombres de fichero"; el chasquido <Se aplica>.  

 Ate Comentarios a nodos de árbol En cada nodo del árbol, vea el comentario asociado con la llamada de función: 

Seleccione "el Comentario Asociado"; el chasquido <Se aplica>. 

 Los objetos usados por funciones Seleccione “el Nombre de Objeto”; el chasquido <Se aplica>. 

Use "la tarjeta" de Búsqueda de Objeto para buscar objetos de datos específicos y mostrarlos en los nodos de 
árbol relevantes 

4.  Que funciona el uso una categoría de 
objetos  

Use "la tarjeta" de Búsqueda de Objeto de la Búsqueda en el diálogo de Árbol 

 La lista de vista de globals usada por 
cada función 

− Juego "Tipo de Objeto" <a Globals>  

− Juego "Escogido" de a <Alguno Global>.       

A este punto, "el Nombre de Objeto" contiene <a Alguno Global>  

− Haga clic <Buscan> 

 La lista de Estructuras usada por cada 
función  

− Juego "Tipo de Objeto" <a Estructuras/Uniones> 

− Juego "Escogido" de a <Cualquier Unión de Estructura/Cualquier>.      

Ahora "el Nombre de Objeto" contiene <Cualquier Unión de Estructura/Cualquier>. 

− Haga clic <Buscan> 

 Qué miembros de una Estructura están 
usados por las funciones 

− Juego "Tipo de Objeto" <a Estructuras/Uniones>  

− En "Escogido De", seleccione el nombre de la estructura en la cual usted está interesado 

A este punto, "el Nombre de Objeto" contiene el nombre de la estructura 

− De Chasquido 'de Miembros' en punto o flecha es decir“. "o"->” 

− Juego "Escogido" de a <Cualquier Miembro>. 

Ahora "el Nombre de Objeto" contiene: "nombre de la estructura deseada". <Cualquier Miembro> 

− Haga clic <Buscan> 

5.  Que funciona el uso un objeto específico: Use "la tarjeta" de Búsqueda de Objeto de la Búsqueda en el diálogo de Árbol 
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 Que funciona el uso un global específico − Juego "Tipo de Objeto" <a Globals> 

− En "Escogido De", use la lista desplegable para seleccionar el nombre de la variable global en la cual 
usted está interesado 

Ahora "el Nombre de Objeto" contiene el nombre de la variable global 

− Haga clic <Buscan> 

 Que funciona el uso un miembro 
específico de una variable de estructura 
específica 

− Juego "Tipo de Objeto" <a Estructuras/Uniones>  

− En "Escogido De", seleccione el nombre de la variable de estructura en la cual usted está interesado 

A este punto, "el Nombre de Objeto" contiene el nombre de la variable de estructura 

− De Chasquido 'de Miembros' en punto o flecha es decir“. "o"->” 

− En "Escogido De", seleccione el nombre del miembro específico en el cual usted está interesado 

Ahora "el Nombre de Objeto" contiene: "nombre de la estructura deseada" "nombre del miembro deseado" 

− Haga clic <Buscan> 

6.  Búsqueda Avanzada En “la" tarjeta de Búsqueda Avanzada “de la Búsqueda en Árbol” diálogo: 

 Vaya al siguiente nodo que es de un 
archivo específico 

− Seleccione "el Nombre de fichero" checkbox. (la casilla de verificación de "Search String" debería ser 
DESCONECTADA) 

− Use la lista desplegable para seleccionar el nombre del archivo en el cual usted está interesado. 

− Haga clic <Búsqueda> para encontrar el siguiente nodo de árbol que es del archivo seleccionado; Haga 
clic <en la Búsqueda Todos> para encontrar todos los nodos que son del archivo seleccionado. 

 Vaya al siguiente nodo que usa un 
objeto específico 

− Seleccione “el Nombre de Objeto” checkbox. (la casilla de verificación de "Search String" debería ser 
DESCONECTADA) 

− Use la lista de historia para seleccionar el objeto en el cual usted es interersted. 

− Haga clic <Búsqueda> para encontrar el siguiente nodo que contiene el nombre de objeto; Haga clic <en la 
Búsqueda Todos> para encontrar todos los nodos que contienen un partido para el objeto seleccionado. 

 Busque una cuerda en nodos del árbol − Seleccione “la Cuerda de Búsqueda” checkbox. 

− Ingrese el nombre de la cuerda que usted desea buscar. 

− Haga clic <Búsqueda> para encontrar el siguiente nodo que contiene la cuerda; Haga clic <en la Búsqueda 
Todos> para encontrar todos los nodos que contienen un partido para la cuerda seleccionada. 

7.  Destaque otros Acontecimientos Use el "Permiten la Demostración” tarjeta en “la Búsqueda en el Árbol” diálogo 
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 Los nodos de toque de luz que tienen el 
mismo nombre de función que el nodo 
corriente 

Seleccione “el Nombre de Función”; el chasquido <Se aplica>.  

 Los nodos de toque de luz que son del 
mismo archivo que el nodo corriente 

Seleccione "el Nombre de fichero"; el chasquido <Se aplica>.  

 Los nodos de toque de luz que hace atar 
el mismo nombre del objeto que el nodo 
corriente 

Seleccione “el Nombre de Objeto”; el chasquido <Se aplica>.  

8.  El chasquido solo para ir a la llamada de la 
función 

Un chasquido solo en un nodo en el árbol de la Llamada: 

− mueve el cursor a la primera llamada de la función en el código del padre 

− Los chasquidos subsecuentes moverán el cursor a la siguiente llamada de la función en el código del 
padre 

9.  Vea el DataFlow del objeto de datos − Haga clic para seleccionar un nodo del árbol que hace mostrar un objeto de los datos junto a ello  

− El chasquido correcto en todas partes en la Ventana de Árbol, luego haga clic <en DataFlow para el Objeto 
Corriente> en el menú instantáneo.  

10.  Filtración del árbol Después de buscar de una función específica en el árbol, o cuando la información es atada a los nodos de 
árbol, usted puede filtrar el árbol de modo que sólo los nodos de interés sean visibles y el resto del árbol se 
hace escondido. 

 Sólo vea los nodos que tienen objetos Después de que usted busca un objeto y, como consiguiente, aquel objeto es mostrado junto a unos nodos en 
el árbol: 

− Chasquido correcto en todas partes en la Ventana de Árbol. 

− Haga clic <Muestran Todos los Caminos para el Objeto>. 

Ahora sólo los subárboles que contienen los nodos con los objetos son visibles, el resto del árbol se hace 
escondido. 

 Los nodos de vista que son de un 
archivo específico 

Después de que usted permite la demostración de nombres del archivo, de modo que los nombres del archivo 
sean mostrados junto a los nodos del árbol: 

1. Seleccione un nodo que contiene el nombre del archivo de interés. 

2. Chasquido correcto en todas partes en la Ventana de Árbol. 

3. Haga clic <Muestran Todos los Caminos para el Nombre del archivo>. 

Ahora los subárboles que contienen los nodos con el nombre del archivo de interés son visibles, el resto del 
árbol se hace escondido. 



 2010  SGV Software Automation Research Corp.  SGV SARC, Crystal REVS, SGV SARC logo are trademarks of  SGV Software Automation Research Corp. All rights reserved. 
 

30 

 Busque TODOS  Como "Búsqueda TODOS" los trabajos: el Cristal buscará para encontrar todos los nodos basados en el criterio 
de búsqueda.  

Si alguna parte no ampliada del árbol contiene los partidos de búsqueda, aquellas partes serán 
automáticamente ampliadas. 

Sólo los subárboles que contienen los partidos de búsqueda permanecen visibles, el resto del árbol se hace 
escondido. 

 Muestre Árbol Entero Cuando unos subárboles son visibles y el resto del árbol es escondido, las nuevas búsquedas y unas otras 
operaciones no pueden ser realizadas.   

Mostrar el árbol entero otra vez:  

− Chasquido correcto en todas partes en la Ventana de Árbol. 

− Haga clic <Muestran el Árbol Entero>. 
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9. Flujo de datos 

1. Cree un DataFlow − Coloque el cursor en un nombre de objeto en la ventana de archivo. 

− Haga clic en el <Crean DataFlow> e n la barra de herramientas. 

 ¿Qué hace espectáculo de DataFlow? − Las declaraciones que usan el objeto de datos, las llamadas de la función que toman el objeto de datos 
como un argumento 

− El flujo de control alrededor del uso de objeto de datos 

 
DataFlow le permite: 

− Rápidamente encuentre todas las funciones que usan el objeto de datos,  

− Como ellos usan el objeto de datos – consiguen una vista completa del uso de datos 

− Cuando pasado como un argumento, amplíe la llamada de la función - para ver como está usada en la 
función llamada 

− Con la vista gráfica, usted puede entender y recordar mucho más rápido. 

2. DataFlow de un vecino Una variable local sólo es conocida dentro de una función.  

− Cuando usted crea el DataFlow de una variable local, usted verá como está usado en la función corriente. 

− Cuando pasado como un argumento, amplíe la llamada de la función - para ver como está usada en la 
función llamada 

3. DataFlow de un global Una variable global es visible a más de un function:. 

− En el DataFlow para un global, usted verá todas las funciones donde el global está usado. 

− Presione dos veces el ratón y amplíe cualquiera de aquellas funciones para ver el uso del global en aquella 
función. 

4. Dataflow de casos de un struct  DataFlow de un miembro struct en todos los casos del struct 

− Vaya a la declaración de miembro y coloque el cursor en el nombre del miembro. 

− Haga clic en el <Crean DataFlow> e n la barra de herramientas 
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 Dataflow de un caso de un struct  DataFlow de un miembro struct en un caso particluar del struct 

− Vaya al código donde está usado como el miembro de aquel caso particular.  

−  Coloque el cursor en el nombre del miembro. 

− Haga clic en el <Crean DataFlow> en la barra de herramientas 

 Dataflow de todos los casos de un 
struct 

DataFlow de todos los casos de un struct 

− Coloque el cursor en el nombre de estructura es decir la etiqueta de struct. 

− Haga clic en el <Crean DataFlow> en la barra de herramientas 

5. Amplíe la llamada de la función en un 
DataFlow 

La presencia de una llamada de la función que implica el objeto de datos es indicada por el icono encima 
del símbolo. 

− Presione dos veces el ratón en un símbolo que contiene una llamada de función.  

La extensión es insertada justo antes de la llamada de función. 

 Colapso una extensión Presione dos veces el ratón en el símbolo de principio de la extensión 

6. Vea el código cubierto por símbolos en 
miniatura 

− Haga clic en símbolos en miniatura y vea el código cubierto por ellos. 

 La voluta destacó el código − Haga clic el <Código de Voluta> y < Código de Voluta Abajo> e n la barra de herramientas de ventana 
Flowchart 

7. Fácilmente navegue a muchas funciones en 
muchos archivos 

Haga clic en un símbolo de organigrama y vea el código correspondiente en el Archivo de la Fuente 

− Haga clic en el símbolo que contiene “el Rastreo:.” para ir al principio de la función en ventana de archivo. 

− En una extensión DataFlow, haga clic en el símbolo de principio para ver la llamada de la función en la 
ventana de archivo  

8. Vea el CallStack Cuando usted amplía llamadas de la función en un DataFlow, a menudo usted tiene una secuencia de 
DataFlows que son anidados el uno en el otro: 

Ver la secuencia de funciones que le trajeron a una extensión anidada: 

− El chasquido correcto en cualquier símbolo en la extensión anidada  

− Seleccione <Pila de Llamada de Función> en el menú instantáneo  

Ahora usted puede ver la pila de llamada llena. 

− Haga clic en un nombre de la función en la pila de la llamada para ir a su extensión 
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9. Vea el organigrama lleno de la función  − Haga clic en cualquier símbolo en el DataFlow de modo que el código correspondiente sea destacado en 
la Ventana de Archivo.  

− Haga clic e n la barra de herramientas principal encima.  

 Vuelva a DataFlow Volver al DataFlow: 

− Haga clic <detrás a Organigrama> e n la barra de herramientas de Organigrama 
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10. Llame Flujo 

1. Cree un CallFlow − Coloque el cursor en todas partes en la función. 

− Haga clic el <Crean CallFlow> e n la barra de herramientas. 

2. Lo que hace usted se pone con el CallFlow Usted consigue una vista simplificada de la función. Usted puede ver fácilmente: 

− las funciones llamaron en aquella función 

− el flujo de control de la función 

3. Vea el código cubierto por símbolos en 
miniatura 

− Haga clic en símbolos en miniatura y vea el código cubierto por ellos. 

 La voluta destacó el código 
− Haga clic el <Código de Voluta> y < Código de Voluta Abajo> . 

4. CallFlow le permite: − Haga un ataque rápido contra la función corriente y sus llamar-funciones  

− Entienda la lógica de una función detalladamente  

5. Amplíe llamadas de la función en un 
CallFlow 

En CallFlow, la presencia de una llamada de la función es indicada por el icono encima del símbolo. 

− Presione dos veces el ratón en un símbolo que contiene una llamada de función.  

La extensión es insertada justo antes de la llamada de función. 

 
Colapso una extensión − Presione dos veces el ratón en el símbolo de principio de la extensión 

6. 

 

Fácilmente navegue a muchas funciones en 
muchos archivos 

Haga clic en un símbolo de organigrama y vea el código correspondiente en el Archivo de la Fuente 

− Haga clic en el símbolo que contiene “el Rastreo:.” para ir al principio de la función en ventana de archivo. 

− En una extensión CallFlow, haga clic en el símbolo de principio para ver la llamada de la función en la 
ventana de archivo  
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7. Vea el CallStack Cuando usted amplía llamadas de la función en un CallFlow, a menudo usted tiene una secuencia de CallFlows 
que son anidados el uno en el otro: 

Ver la secuencia de funciones que le trajeron a una extensión anidada: 

− El chasquido correcto en cualquier símbolo en la extensión anidada  

− Seleccione <Pila de Llamada de Función> en el menú instantáneo  

Ahora usted puede ver la pila de llamada llena. 

− Haga clic en un nombre de la función en la pila de la llamada para ir a su extensión 

8. Vea el organigrama lleno de la función  
− Haga clic en cualquier símbolo en el CallFlow de modo que el código correspondiente sea destacado en la 

Ventana de Archivo.  

− Haga clic e n la barra de herramientas principal encima.  

 
Vuelva a CallFlow Volver al CallFlow: 

− Haga clic <detrás a Organigrama> e n la barra de herramientas de Organigrama 
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11. Árboles de dependencia de los datos 

1. Cree un Árbol de dependencia de los Datos  Coloque el cursor en cualquier objeto de los datos.  

− Haga clic <Crean el Árbol de Dependencia de Datos> i cono en la barra de herramientas. 

 Árbol de dependencia de los Datos de 
un global 

Coloque el cursor en un global y cree es el árbol de dependencia de los datos. 

El árbol de dependencia de los datos de una variable global contendrá 

− Todos los acontecimientos donde la variable global está siendo modificada 

− Si una variable global está siendo pasada como un argumento de función, entonces el nombre de la 
función. 

− Todos los acontecimientos modificados de los objetos que modifican la variable global; etcétera. 

 Árbol de dependencia de los Datos de 
un vecino 

Coloque el cursor en un vecino y cree es el árbol de dependencia de los datos. 

 Árbol de dependencia de los Datos de 
un miembro 

Coloque el cursor en el miembro de estructura y cree es el árbol de dependencia de los datos. 

El árbol de dependencia de los datos contendrá: 

− Todos los acontecimientos modificados del miembro. 

− Todos los acontecimientos modificados de los objetos que modifican al miembro 

− Si el miembro está siendo pasado como un argumento, entonces el nombre de la función. 

2. Amplíe el árbol de dependencia de los Datos Amplíe los nodos del árbol de dependencia de los Datos haciendo clic en “+” 

 Amplíe el Árbol entero Ampliar totalmente el subárbol bajo el nodo corriente,  

Chasquido correcto en todas partes en la ventana Tree; Haga clic <Se amplían Lleno> 

3. Navegación Presione dos veces el ratón en cualquier nodo en el árbol de dependencia de los Datos para ir a la 
línea de código fuente correspondiente. 
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4. Prefijos de Nodo − A - indica que el nodo es una serie  

− D - indica que el nodo es una constante definida  

− E - indica que el nodo es una variable enum 

− F - indica que el nodo es una función 

− G - indica que el nodo es un global 

− M - indica que el nodo es el miembro de unión o la estructura 

− P - indica que el nodo es una aguja 

− T - indica que el nodo es un typedef 

− CE - indica que el nodo es una constante enum 

− LA FA - indica que el nodo es un argumento de función 

− FP - indica que el nodo es la aguja para funcionar 

− GA - indica que el nodo es una serie global 

− EL DIPUTADO - indica que el nodo es una aguja de miembro 

− +     - indica que el nodo es EXAPANDALBLE 

- -      - indica que el nodo es AMPLIADO 

- *      - indica que el nodo es RECURRENTE 

5. “La Búsqueda en Árbol” diálogo Haga clic el <Búsqueda en el Árbol> e n la barra de herramientas de Ventana de Árbol para ver “la Búsqueda en el 
diálogo de Árbol”.  

 

 La tarjeta de Demostración Permitir Use esta tarjeta para: 

− Permita/incapacite la información que es mostrada junto a cada nodo 

 La tarjeta de acontecimientos de Toque 
de luz 

Use esta tarjeta para: 

− Seleccione el criterio por el cual otros acontecimientos de un nodo son destacados  

 La tarjeta de Búsqueda Avanzada Usando esta tarjeta, usted puede: 

− encuentre el siguiente acontecimiento de un nombre de objeto  

− encuentre el siguiente objeto usado de un archivo específico. 

− encuentre el siguiente acontecimiento de una función en el árbol.  

− use "la lista de historia" para buscar un objeto particular, struct, clase, escribir a máquina o #de fino  

− busque una cuerda en todo el texto que está siendo mostrado en los nodos del árbol..  
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6. 

 

Ate la información a nodos de árbol Cada nodo en los espectáculos de árbol de dependencia de los datos   

1. Nombre de objeto de datos    

2. nombre de función    

3. nombre de fichero    

4. Número de línea 

Use el "Permiten la Demostración” tarjeta en “la Búsqueda en el Árbol” diálogo 

 La función de vista llama en que los 
objetos están usados 

Seleccione “el Nombre de Función”; el chasquido <Se aplica>. 

 Nombres de fichero donde Objetos están 
usados 

Seleccione "Nombres de fichero"; el chasquido <Se aplica>.  

 Ate Comentarios a nodos de árbol En cada nodo del árbol, vea el comentario asociado con la llamada de función: 

Seleccione "el Comentario Asociado"; el chasquido <Se aplica>. 

 Los objetos usados por funciones Seleccione “el Nombre de Objeto”; el chasquido <Se aplica>. 

Use "la tarjeta" de Búsqueda de Objeto para buscar objetos de datos específicos y mostrarlos en los nodos de 
árbol relevantes 

7. Busque un Objeto en el Árbol de 
Dependencia de Datos 

Use “la" tarjeta de Búsqueda Avanzada “de la Búsqueda en el Árbol” diálogo 

8. Ver el acontecimiento de un objeto 
profundamente en el Árbol 

− Seleccione el nodo correspondiente al objeto 

− El chasquido correcto en la ventana de árbol, y, luego hace clic <en el Camino de 
Espectáculo>. Ahora usted puede ver el camino de la raíz al nodo para el objeto. 
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12. Generación de Documentación de HTML 

1. Genere Documentación de HTML − Haga clic en Documento de HTML Project→Create  

− En HTML Diálogo de Ajustes de Documenter, seleccione las opciones deseadas.  

− Haga clic <OKEY> 

Crystal C/C ++ comenzará a crear la documentación de HTML para el proyecto corriente.  

Cuando la documentación completa:  

− Haga clic <OKEY> - el documento de falta será mostrado en su navegador. 

 Documento de HTML abierto Abrir la documentación de HTML para el proyecto corriente: 

− Haga clic en Documento de HTML Project→Open 

 Incluso información Específica de 
Proyecto 

Incluir notas de proyecto, comentarios, historia de desarrollo, en cualquier proyecto específico contenido 
relacionado en la documentación: 

− Haga clic en Notas de Project→Open – para abrir el archivo de notas de proyecto 

− Entre en el contenido para ser incluido como la parte de la documentación en el archivo de notas de 
proyecto y salvarlo. 

− Ahora cree la documentación.  

 La configuración del Contenido de 
Documentación de HTML 

Use HTML Diálogo de Ajustes de Documenter para configurar los contenido de la documentación de HTML. 

2. Documentación de HTML provee − Inspección por todo el equipo de código fuente 

− Publique el código fuente en Internet y CD-ROM 

− Código fuente lleno que hojea en ausencia de un IDE. 

 Documentos de HTML también 
proveen 

− Información completa – incluso organigramas, árboles, métrica del código, remisión, etc. 

− Fácil a hojear, fácil a entender, amplia cobertura de código 

− Plataforma ideal para hablar de diseños con clientes y equipos globales – sin realmente transferir código 
fuente. 

3. Contenido de Documentos de HTML de 
Cristal 

− Documentación de archivo  

− Incluir-árbol de Archivo  

− Listado de código fuente - embellecido y destacado por la sintaxis.  

− Organigramas para todo-funciones  

− Árbol de la llamada, árbol del visitante, etc.  

− Métrica de Código  
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− Remisión  

− Documentación de Control Estática  

4. HTML diálogo de ajustes de Documenter Configure los contenido de los documentos aquí. 

 La especificación de la carpeta de 
documentación 

− Especifique el camino donde la documentación debe ser creada en “el Camino para Documentos”. 

 El cambio de la documentación Título − Entre en “el Título de Documentación” en el panel de Título de Informe 

 La atadura de un logotipo a la 
documentación 

− Hojee y elija el archivo de LOGOTIPO para la documentación. 

 Permita métrica del Código  Bajo la sección General: 

− Compruebe ‘Permiten a Métrica de Código’ incluir la métrica de código como la parte de la documentación 

 Incluya el listado de código fuente En la Sección de Código fuente: 

− Compruebe ‘el Listado de Código fuente’ - el código fuente formateado para cada archivo va para ser 
incluido en la documentación.  

 Incluya informes de control estático En la Sección de Control Estática: 

− Seleccione "Permiten el Inspector Estático" al control estático cada archivo de proyecto Cuando 
seleccionado, el 'MISRA C’ informe de comprobación estático para el proyecto será la parte del proyecto.  

 Incluya organigramas de función  En la sección de Organigramas: 

− El Control Permite a creación de Organigrama incluir organigramas para todas las funciones de proyecto 
como la parte del documento. 

− Compruebe – Uñas del pulgar con Altura y Anchura  

− Elija el tipo del organigrama con el nivel del detalle. 

 Incluya varios tipos de árboles  Use la sección de Árboles para seleccionar los tipos de árboles para ser incluidos como la parte de la 
documentación de HTML. Usted puede seleccionar de  

5. La ojeada en documentación de HTML La página de inicio para cada juego de documentación es “default.html”. Vea el resumen de proyecto aquí. 

Entonces, haga clic en el Árbol de Overview→Browse de proyecto para ver el árbol de Proyecto. Úselo para 
navegar en la documentación. 

 Proyecto Hojea Árbol − Amplíe los nodos a del árbol,  

 Documentación de Archivo Vea la documentación individual de un archivo. Usar 

− Árbol de Informe de Archivo 
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− Documentación 

− Listado de Código fuente 

 Métrica de Código La documentación de HTML contiene la Métrica de Volumen siguiente: 

− Métrica de Proyecto 

− Métrica de Archivo 

− Métrica de Función 

Usted también puede ver la Métrica de Complejidad siguiente: 

− La Métrica de Complejidad de Halstead 

− La Métrica de Complejidad de McCabe 

 Remisión Vea la lista de todo globals en el proyecto, junto con donde el objeto ha sido definido y usado. 

 Informe de Control Estático Vea el informe de control estático – en un por archivo o un por base de regla. 

6. Menús de Documentación Por favor vea los contenido de Ayuda. (Html Documentation→Menus …) 
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13. Comprobación estática 

1. Informe de Comprobación Estático para un 
Proyecto 

Al control estático un proyecto, haga clic en el Informe de Inspector Estático Project→Create. 

En el diálogo de Inspector estático, seleccione: 

− El Tipo de Regla de la lista desplegable  

− Las reglas para ser comprobadas bajo el Tipo de Regla  

− El formato de informe de salida.  

− Haga clic <OKEY>. 

El metro de progreso de Inspector Estático será mostrado 

Tan pronto como la generación de informe es completa, los resultados serán mostrados en el formato 
seleccionado. 

 Comprobación Estática de un Archivo Al control estático un archivo, haga clic Instrumentos los � Crean el Informe de Inspector Estático. 

 Qué estándares de Comprobación 
Estáticos son apoyados 

Usted puede elegir de: 

− MisraRule1998 - para MISRA-C:1998  

− MisraRule2004 - para MISRA-C:2004  

2. Seleccione las Reglas de Comprobar Antes de que usted comience la comprobación estática,   

− Seleccione las reglas para ser comprobadas 

− No seleccione las reglas de las cuales usted quiere no hacer caso 

3. El diálogo de Control Estático Use este diálogo y controle la generación de informes de comprobación estáticos. 

 Ajustes Use el menú de ajustes para Importar o Exportar un conjunto de reglas predefinido para ser comprobado. 

 Tipo de Regla y Lista de Reglas Eligió el estándar para comprobar y luego seleccionar las reglas de comprobar/hacer caso de la lista de reglas 

 Ajustes Generales Relatando violaciones, si el find's de REVS de cristal una violación conocida que ha sido marcada en el código 
para no ser relatada, no se relatará en la salida si 'el Informe todas las violaciones no que hacen caso de 

pragmas introducido' es no comprobado. 
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 Formatos de salida El resultado de una prueba de violaciones de control estática puede ser: 

− Visto en la Ventana de Salida dentro de Crystal C/C ++. Usted puede navegar, ver y corregir estas 
violaciones 

− Visto cuando los informes de HTML generados en una carpeta especificada. Pueden dar estos informes de 
HTML a los otros miembros de un equipo de desarrollo para fijar varias violaciones. 

4. Inspección del Informe Usted puede ver un informe estático en “el Inspector Estático” la etiqueta de la ventana de salida. 

5. La exclusión de violaciones conocidas de 
ser relatado 

Para violaciones que son conocidas existir en un proyecto, usted puede querer suprimir el reportaje de ellos 

cada vez.  

Para hacer así, marque tales violaciones en el código fuente. 

 La supresión de violaciones para el 
archivo entero 

Suprimir las reglas 5.5 y 5.6 de reportaje de 2004 MISRA 
− Al principio del encarte de archivo /*#pragma incapacitan (MISRA2004, 5.5, 5.6) */ 

 La supresión de violaciones para una 
variedad dada 

Suprimir las reglas 5.5 y 5.6 de reportaje de 2004 MISRA 

− Al principio del encarte de variedad /*#pragma incapacitan (MISRA2004, 5.5, 5.6) */ 

− Al final de la variedad para no hacer caso 5.5, el encarte /*#pragma permite (MISRA2004, 5.5) */ 

− Al final de la variedad para no hacer caso 5.6, el encarte /*#pragma permite (MISRA2004, 5.6) */ 

 Añadir una razón suprimiendo una 
violación 

Suprimir el reportaje gobierna 45:2 de 1998 MISRA 
− Al principio del encarte de variedad  

/*#pragma incapacitan (MISRA1998, 45.2: ”esto gobierna ha sido suprimido.”) */ 

Usted puede usar cualquier serie de su opción después del colon ’:’ 

6. Informes de Control Estáticos y 
Documentación de HTML 

El informe de control estático puede ser la parte de la documentación de HTML. 

Incluir el informe de control estático:  

− Haga clic en documento de HTML Project→Create  

− Permita Inspector Estático  

7. Informes de Control Estáticos y modo de 
Línea de Orden 

El informe de control estático también puede ser generado en el modo de línea de orden.  

Por favor vea los contenido de Ayuda. (Comprobación Estática → …) 
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14. Comentario Rastro 

1. Informe de Cambio de Software El informe de Jalón de Rastro de Comentario es el informe de cambio de software.  

Todos los cambios de software bajo un Cambio solo ID son agrupados y rastreados juntos. 

2. La creación de un Jalón de Rastro de 
Comentario 

− Haga clic en el Rastro de Insert→Comment Jalón de Rastro de Comentario de Marker→New y cree el que. 

− El chasquido <Ahorra> para salvar el Jalón de Rastro de Comentario creado. 

3. Formato de Jalón de Rastro de comentario Un jalón de rastro de comentario típico mira como sigue 

CTM: ListOverflow JohnD 24/11/2009: incremento de aguja perdía aquí ENDCTM 

4. Insertar Jalones de Rastro de Comentario − Haga clic en Rastro de Insert→Comment Marker→ListOverflow 

Usted puede seleccionar cualquier Jalón de Rastro de Comentario de su opción. 

5. La Inspección de Informe de Jalón de Rastro 
de Comentario 

− Haga clic en el Jalón de Rastro de Tools→Comment Report→ListOverflow para ver la lista de todos los 
jalones de rastro de comentario bajo el ID ListOverflow 

− El informe de Jalón de Rastro de Comentario será mostrado en la ventana de salida en la tarjeta de 
Informes.. 

6. Vea una lista de todos los Jalones de Rastro 
de Comentario en el proyecto 

En la Ventana Hojear,  

− Vista el Prj Hojea Tarjeta 

− Haga clic y amplíe el nodo “Jalones de Rastro de Comentario” 

− Haga clic en un Jalón de Rastro de Comentario para ver es el informe. 

7. La Supresión de Jalones de Rastro de 
Comentario 

Quitar acontecimientos de un Jalón de Rastro de Comentario del proyecto 

− Haga clic en Jalón de Rastro de Comentario de Tools→Remove 

Alternativamente, usted puede el chasquido correcto en un Jalón de Rastro de Comentario en la ventana Prj 
Browse, o, usar el icono <Quitar> en la ventana Report. 
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15. Diagramas de Transición estatales 

1. Máquina estatal en un organigrama − Una frontera rectangular es dibujada alrededor de la secuencia de declaraciones que equivalen a un 
estado.  

− Una o varias declaraciones en un estado pueden provocar una transición a otro estado. Una transición es 
mostrada dibujando una flecha de aquella declaración a la frontera del estado de destino.  

− Usted puede atar un comentario o una nota a una flecha de transición. 

2. Máquinas estatales como un caso del 
interruptor 

A menudo una máquina estatal es cifrada en la forma de un caso del interruptor 

 La ampliación y el derrumbamiento de 
un interruptor 

− Presione dos veces el ratón en un símbolo de interruptor para caer el interruptor entero a un símbolo de 
alto nivel.  

− El chasquido correcto en el símbolo de alto nivel, luego haga clic <Amplían el Símbolo> en el menú 
instantáneo. El interruptor será totalmente ampliado.  

− Presione dos veces el ratón en el símbolo de alto nivel para ampliar el interruptor en dos niveles  

3. Cree una Transición estatal – proceso Crear un Diagrama de Transición estatal: 

− Encierre cada estado en una frontera rectangular 

− Cree una Transición estatal 

− Cambie el encaminamiento de una Transición estatal 

− Proporcione un comentario a una Transición estatal 

 Encierre cada estado n una frontera 
rectangular 

Marcar sólo unos casos como estados: 

− El chasquido correcto en el símbolo de caso deseado.  

− Haga clic: Diagrams→Mark estatal como estado  

En general, usted también puede el chasquido correcto en un para, mientras, hacer, si el símbolo y marca el 
cuerpo entero como un estado. 

Usted también puede marcar todos los casos como un estado en uno va.  

 Cree una Transición estatal − Identifique la declaración que causa una transición a otro estado (declaración más bien cuidada).  

− El chasquido correcto en el símbolo de declaración más bien cuidado, luego haga clic: Transición de 
Diagrams→Create estatal.  

− En el cuadro de diálogo de "Flowchart State Transition", especifique el estado que resulta.  

− Entonces, proporcione un comentario que será atado a la flecha de transición 
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 Cambie el encaminamiento de una 
Transición estatal 

− El chasquido correcto en el símbolo que contiene la declaración más bien cuidada.  

− Haga clic: Ruta de Diagrams→Transition estatal  

− En "el diálogo" de Ruta de Transición de Organigrama, cambie "El" "de" "y" "a" ajustes. 

 Proporcione un comentario a una 
Transición estatal 

− El chasquido correcto en el símbolo que contiene la declaración más bien cuidada.  

− En el menú instantáneo, haga clic: Comentario de Diagrams→Add estatal a Transición  

4. La modificación del comentario en una 
Transición estatal 

− El chasquido correcto en el comentario atado a la Transición estatal.  

− Haga clic: Propiedades de Comentario de Diagrams→Transition estatales  

− ¡Proporcione el nuevo comentario allí! 

5. Muestre la Transición estatal con un nivel de 
detalle deseado 

− El chasquido correcto en el símbolo de interruptor, luego haga clic: Diagrams→Collapse estatal Todos los 
Casos.  

− Presione dos veces el ratón en el símbolo de interruptor para caer el interruptor.  

− Presione dos veces el ratón en el símbolo de alto nivel. El interruptor es ampliado a dos niveles del detalle.  

− Presione dos veces el ratón en el símbolo de interruptor para caer el interruptor.  

− El chasquido correcto en el símbolo de interruptor, luego haga clic Amplían el Símbolo. Usted consigue un 
Diagrama de Transición estatal totalmente ampliado.  

6. Salvar el Diagrama de Transición estatal Salvar el Diagrama de Transición estatal: 

− El chasquido correcto en todas partes en la ventana de organigrama.  

− En el menú instantáneo, haga clic: Diagrams→Save & Close Flowchart estatal.  
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16. Corrija Operaciones 

1. Encarte {} alrededor de declaraciones solas En un archivo,   

− Haga clic en Insert→Insert {} alrededor de declaraciones solas 

Crystal C/C ++ explora el archivo para todas las declaraciones de condición como si (), para (;;), mientras (), 
hacen (), etc. que no son seguidos de un par de '{}’. 

Esto inserta 'un {' inmediatamente después de la declaración de condición;  

Esto inserta 'un}' inmediatamente después de la declaración siguiente.  

2. Cambio SÍ Y NINGUNAS partes de un si.. 
más, declaración 

− Coloque el cursor en un "si () declaración” "o un más" 

− Haga clic en Edit→Logic Change→Swap las partes de if_else_statement 

3. El cambio hace mientras a mientras lazo − Coloque el cursor en un "hacen la declaración”  

− Haga clic en Edit→Logic Change→Change do_while lazo a mientras lazo 

4. Cambio mientras lazo para hacer mientras 
lazo 

− Coloque el cursor en un "mientras () declaración”  

− Haga clic en Edit→Logic Change→Change mientras lazo para hacer.. mientras lazo 

5. Tirantes de Nuevo partido − Coloque el cursor dentro de una función 

− Haga clic en Edit→Logic Change→Rematch Tirantes 

6. No comentario No comentar: 

− Coloque el cursor dentro de/* de bloque de comentario */ 

− Haga clic en Edit→Uncomment 

7. Comentario con/* */ − Seleccione un bloque de texto para ser comentado. 

− Chasquido correcto, luego haga clic en el Comentario usando/* */ 

8. Comentario con// − Seleccione un bloque de texto para ser comentado. 

− Chasquido correcto, luego haga clic en el Comentario usando// 

9. Condición / Código − Seleccione el bloque de código para ser cifrado 

− Chasquido correcto, luego haga clic en la Condición 
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10. Encierre en {}  − Seleccione las líneas para ser encerradas en {}  

− Chasquido correcto, luego haga clic Encierran en {} 

11. Encierre en () − Seleccione la condición para ser encerrada en ()  

− Chasquido correcto, luego haga clic Encierran en () 

12. Suprima a un par {de}. (), [], etc. − Coloque el cursor dentro del par {de}, (), [], etc. que usted desea quitar 

− Haga clic en el botón <DelPair> 

13. Comentarios de Movimiento a derecho Si los comentarios son rociados entre las declaraciones, usted puede conseguir una vista ininterrumpida 
del código: 

− El Chasquido Corrige Comentarios de Movimiento de � → Mueven Todos los Comentarios al campo 
del Comentario. 

 

14. Cambie una declaración o Abajo En el Panel de Señales, 

− Haga clic <MvSnt ↑> para mover la oración corriente hacia arriba 

− Haga clic <MvSnt ↓> para mover la oración corriente hacia abajo 

15. Seleccione la función entera, un rato lazo, 
un caso entero, etc. 

Coloque el cursor en la función deseada, o declaración 

− Haga clic en el icono de Bloque Escogido en la barra de herramientas principal. 

− Elija de la lista desplegable. 

16. Tabillas con sujetapapeles Múltiples Haga clic en Edit→Paste→Paste # N para mostrar Tabilla con sujetapapeles Múltiple. 
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17. Formateo para legibilidad mejorada 

1. Crystal C/C ++ Formatter − Formatter del Flujo de Cristal es basado en el analizador sintáctico. Esto hace mucho más que un 
formatter que usa el análisis léxico sólo. 

− Alineación de tipo specifiers, declarators entre declaraciones consecutivas 

− Alineación de operadores de asignación entre declaraciones de asignación consecutivas 

− El formateo de expresiones largas que toman más de una línea - basado en la precedencia de operadores 

− El formateo apropiado de definiciones macro que contienen muchas declaraciones 

− Mantiene un campo del comentario a la derecha para la legibilidad fácil 

2. El formateo de archivos en Crystal C/C ++ Cuando Crystal C/C ++ abre un archivo por primera vez: 

− Esto usa los ajustes de formato corrientes para formatear el archivo y salva los ajustes de formato en un 
por base de archivo. 

− Cuando usted abre el archivo otra vez, los ajustes de formato salvados están usados para aquel archivo. 

3. Modificar ajustes de Formato Haga clic en Instrumentos → Opciones → Ambiente → Ventana de Archivo → Ajustes de Formato 

− Ponga el Tamaño de Etiqueta y Pedido, etc. 

− Cambie el Estilo de Formateo de Código 

− Cambie el Comentario que Formatea Estilo 

− Selectivamente incapacite el formateo de código o comentarios. 

4. Aplicar el ajuste de formato modificado Aplicar los nuevos ajustes a un archivo que está abierto actualmente: 

− Haga clic en el Archivo Corriente File→Refresh. 

(Hasta que usted Refresque el archivo, sus cambios no serán aplicados al archivo corriente) 

Aplicar los nuevos ajustes a todos los archivos en el proyecto 

− Haga clic en Proyecto de Project→Reparse Files→All 

(Hasta que usted Analice de nuevo el proyecto, sus cambios no serán aplicados al proyecto entero) 

5. Incapacitar formateo automático  Haga clic en Instrumentos → Opciones → Ambiente → Ventana de Archivo → Ajustes de Formato 

− En el Modo de Formato, no seleccione Ninguno. 

− Aplique los ajustes modificados a los archivos como descrito encima. 
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18. Operaciones de hornada 

1. Salida de Hornada de Organigramas − Haga clic en BatchOutput→Flowcharts para Proyecto  

− En el diálogo mostrado, seleccione el tipo de organigrama para ser la salida. 

− Seleccione el nivel de organigrama que debería ser la salida 

− Seleccione el formato objetivo – Visio, Imagen, etc. 

− Seleccione si usted quiere imprimir los organigramas también. 

− Seleccione la carpeta en la cual la salida debería ser creada. 

− Haga clic <OKEY> 

2. Salida de Hornada de Árboles − Haga clic en BatchOutput→Graphs para Proyecto  

− En el diálogo mostrado, seleccione los árboles diferentes usted quiere ser la salida. 

− Seleccione la carpeta en la cual varios árboles deberían ser la salida. 

− Haga clic <OKEY> 

3. Archivos de Imprenta de Hornada − Haga clic en BatchOutput→Files para Proyecto  

− Siga las instrucciones en el diálogo y chasquido <OKEY> 

4. Archivos de Salida de Hornada, 
Organigramas y Árboles 

− Haga clic en BatchOutput→All a Archivos de salida, Organigramas y Árboles en un single van. 
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19. Operaciones Diversas 

1. Proceso previo un Archivo Pretratar un archivo: 

− Haga clic en Tools→Preprocess.  

EL FLUJO de cristal o REVS pretratan el archivo y muestra la salida pretratada en un archivo diferente con el 
mismo nombre "y pre" suffixed en la extensión.  

2. Informes de Métrica de Código Generar vario Informe de Métrica de Código,  

− Haga clic en Métrica de Código de Project→Generate  

En ‘el diálogo’ de Métrica de Código,  

− Seleccione la carpeta objetivo 

− Seleccione el formato de salida 

− Ponga la codificación de color – para valores altos, medios y bajos 

− Haga clic <OKEY>  

Por favor vea los contenido de Ayuda. (Documentación de Html-> Hojeando en el ….-> Métrica de Código) 

3. Publique Código fuente − Haga clic en Código fuente Project→Publish  

− En ‘el diálogo’ de Editor de Código fuente, hojee y seleccione la carpeta de destino 

− Haga clic <OKEY> 

4. Compile un Archivo Compilar el archivo corriente: 

− Haga clic en Tools→Compile  

Los errores y los mensajes de advertencia son mostrados en la ventana de salida en la etiqueta compilar. 

Para seleccionar su compilador, los ajustes, directivas de preprocesador, etc. usan el menú Options. 

 Compile Todos  Compilar todos los archivos: 

− Haga clic en Tools→Compile Todos. El diálogo de Archivos Compilar es mostrado. 

− Seleccione los archivos para ser compilados.  

− El chasquido <Compila> 

Los errores y los mensajes de advertencia son mostrados en la ventana de salida en la etiqueta compilar. 

5. Marcha de Archivos de lote Usted puede dirigir cualquier archivo de lote de Crystal C/C ++ ambiente. Dirigir un archivo de lote: 

− Haga clic en el Archivo de lote de Usuario Tools→Run.  

− En el diálogo, especifique el Archivo de lote para ser ejecutado 

− Haga clic <Carrera>  
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20. Disparos de problema 

Para cualquier disparo/FAQ de apoyo/problema o cualquier otra pregunta, póngase en contacto el 24x7 cuidado de cliente en support@sgvsarc.com 
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